
Additional Notes About Printing in Windows NT
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This document contains information about printing not available in the Microsoft® 
Windows NT® documentation set or in Help, as well as information on changes that occurred 
after publication. Some of the topics in this document are specific to particular printer models or 
printer types, such as PostScript or PCL printers, and some are more general, such as instructions 
on how to print extended characters.

Additional information is available in the Setup.txt, Readme.wri, and Network.wri files. Setup.txt contains information 
about installing Windows NT. Readme.wri contains general information about Windows NT, including information on 
specific hardware and software applications. Network.wri contains information related to networks, including 
information on network adapter cards,  network services, and interoperability.

Using WordPad to View This Document
If you enlarge the WordPad window to its maximum size, this document will be easier to read. To do so, click the 
Maximize button in the upper-right corner of the window. Or open the Control menu in the upper-left corner of the 
WordPad window (press ALT+SPACEBAR), and then click Maximize.

To move through the document, press PAGE UP or PAGE DOWN. Or click the arrows at the top and bottom of the scroll
bar along the right side of the WordPad window.

To have the words wrap to the screen size or the ruler
1. From the View menu, click Options.
2. Click either Wrap to window or Wrap to ruler, and then click OK.

To print the document
1. From the File menu, click Print.
2. Select the printer, and then click OK.

Before you call for support on a printing issue



First gather the following information: 
• Version of Windows NT 
• Service Packs and hotfixes applied 
• Printer make/model 
• Printer driver in use 
• Printer language in use (PCL, PostScript, etc.) 
• Connection to machine (serial/parallel/DLC/LPR) 
• Type of clients 
• Event Log errors 
• Errors displayed on screen of client or server 
• PostSript errors returned by printer 
• Can the print server print when the client cannot?

General Printing Issues
The following issues apply to printing in Windows NT or apply to entire types of printers 
regardless of the manufacturer.

Problems with Printer Names over 32 Characters
Windows NT can create long printer names. However, some applications cannot print to printers 
with names longer than 32 characters. If you experience problems, create a printer with 31 or 
fewer characters in the name.

For printers that are shared, the entire qualified name (including the server name, for example, \\
PRINTER2\PSCRIPT) must be less than 32 characters.

Printing Extended or International Characters
In addition to the 128 standard ASCII characters you can type using your keyboard, you can use 
extended or international characters by using the Character Map application. For more 
information, see Help for Character Map.

When Windows NT prints a file, each character you typed while using your application is 
translated from the Windows NT character to the appropriate character on your printer. If your 
printer supports the same character, the character prints. Otherwise, a character such as a period or 
other filler character prints instead. Check your printer manual and experiment with your printer to
determine which extended characters are supported.

Note
This limitation applies only to the printer's hardware fonts. TrueType fonts provided by Windows 
NT will print extended characters.

Printing Colored Text on Non-PostScript Printers
If text is not one of the primary printer colors (black, red, green, blue, cyan, magenta, yellow, or 
white), the color may be mapped to white and you will not see any text. In other cases, it may be 
mapped to another color.

Using PostScript Printers
If you notice any problems with character spacing when you print to a PostScript printer, see the 
following procedure to correct the problem.
1. Click Start, point to Settings, and then click Printers.
2. Right-click the printer, and then click Document Defaults. 
3. Click the Advanced tab.
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4. In the Graphic section of the tree, click TrueType Font.
5. Click Download as Softfont, and then click OK.
6. Restart the application, and then print the document again.

Using Color Printers
Some Windows 3.1-based and Windows 95-based applications will not print colored text and 
graphic objects on color PCL printers at 24-bpp (True Color).  To produce output with the 
expected colors, print at a lower color depth.

Troubleshooting Plotters
Seven (7) data bit serial connections to plotters are not supported. Use eight (8) data bits.
If some lines are not printing on pen plotters, try setting the plotter (on the plotter's control panel) 
so installed pens are the minimum width supported by the hardware. Some plotters will not print 
thin lines unless the thinnest pen is selected.

Pen plotters can take more time to clear their buffers. You may want to set the port time-out to 
higher values to avoid receiving error messages.

Windows NT plotter drivers for most HP DesignJet series plotters are designed for use with 
margins set to Normal, paper size set to Software, and autorotation set to Off. When 
troubleshooting problems, resetting the plotter to the factory defaults and making only necessary 
changes from the defaults is suggested.

All Windows NT plotting support utilizes the HP-GL/2 language. Some plotters supported by 
Windows NT can be set to receive a choice of plotter languages. To work with Windows NT, HP-
GL/2 must be selected.

When printing to plotter models that offer a choice of roll or sheet media, the form to tray 
assignment must be set to the actual paper size physically available to the plotter. Selecting a cut 
sheet media size when plotting to roll media or roll media when plotting to cut sheet media is not 
supported, and may result in misaligned output.

Converting Type 1 Fonts to TrueType Fonts
The following is a list of Type 1 font vendors who have given permission to convert their fonts to 
TrueType. If a vendor is not listed here, you must contact them for permission to convert a font.

Type 1 Font Vendors
Adobe Systems Incorporated
Alphabets, Inc.
Agfa
Ares Software Corp.
Autologic Inc.
Bear Rock Software Technologies Corp.
Bill Tchakirides, UTF
Bitstream Inc.
Carter & Cone Type Inc.
Castle Systems
Diehl
EmDash
FontShop International
ESSELTE LETRASET LTD
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Type 1 Font Vendors (cont.)
Image Club Graphics, Inc.
Lanston Type Co.
Letter-Perfect/Elsware
Linotype
Linotype-Hell
Miles Inc.
Monotype Typography Inc.
Pre Press Solutions
Page Studio Graphics
The Font Bureau Inc.
The Font Company Inc.
Treacy Faces Inc.
U-Design Type Foundry.
URW Software & Type GmbH
Y&Y
Galiad
Galapagos
Varityper

Caching Print Server Information on Windows NT version 4.0
Checks are made between Windows NT version 4.0 Server and Windows NT Workstation version 
4.0 to make certain the cache is up to date with the print server. If you are using a version of 
Windows NT Server version 3.5 or earlier, and the printer settings or driver on the server have 
been changed since you connected to this printer, information on the cache may not match the 
information on the server. To update the cache on the computer running Windows NT Workstation,
disconnect from the printer, and then reconnect. This will refresh all cached printer settings.

Printing from Windows version 3.1-based Applications
Some Windows version 3.1 applications do not accept port names longer than 5 characters. If you 
are using a monitor (such as DECPSMON or HPMON) that allows you to use a long name and 
you experience problems from older applications, rename the port name to 5 characters.

Using Separator Pages
The default separator pages (PCL.SEP, PSCRIPT.SEP, and SYSPRINT.SEP) may not work with 
some printers.  PCL.SEP is targeted for PCL printers, and may not work unless the PCL printer 
also supports PJL.  PSCRIPT.SEP is targeted toward PostScript printers that also support PJL.  
Also note that PSCRIPT.SEP does not actually print a physical separator page.  SYSPRINT.SEP is
targeted toward PostScript printers and does produce a physical page.

Printers that do not meet the above specifications will require custom separator pages.  For most 
non-PostScript printers (PCL or otherwise), this will produce a basic separator page (only plain 
text with no printer-specific control codes):
\
\B\S\N\4
\I\4
\U\D\4
\E

Micrografx Designer 6.0
Designer (part of the ABC Graphics Suite) may display an error dialog box that refers to 
SMapLS_IP_EBP_12 in KERNEL32.dll when printing to PostScript printers. The dialog box 
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appears because Designer misinterprets the operating system version information and tries to call a
procedure found only in the Windows 95 version of the .dll file. Clicking OK allows printing to 
continue as expected. 

The printer setup property page has a different appearance under Windows NT version 4.0 than it 
does under Windows 95.

Micrografx Designer substitutes a monospace font such as Courier for TrueType fonts.

Contact Micrografx at (214) 234-2694 or online at http://www.micrografx.com for upgrade 
information.

Microsoft Encarta 95
There are known problems printing from Encarta 95 to PCL printers in 24bpp when metafile 
spooling is turned on. You can work around this problem by either turning off metafile spooling or 
by switching to 8 color or 256 color depth in the printer's document properties dialog box.

Printer Drivers
Printer drivers from third party vendors that were used with earlier versions of Windows NT 
cannot be used with Windows NT version 4.0. Contact your print device vendor directly to obtain 
an updated printer driver. 

Existing Windows NT version 3.x drivers are upgraded to Windows NT version 4.0 compatible 
drivers. However, the Windows NT version 3.x drivers are retained for use by Windows NT 
version 3.x clients when connecting to printers shared through a computer running Windows NT 
version 4.0. 

Printers are now set up and accessed from the new Printers folder.

To view the Printers folder 
Click Start, point to Settings, and then click Printers. 

To add a new printer
From the Printers folder, click the Add Printer wizard.

Note
The Add Printer wizard supports the installation of printer drivers for Windows 95, all versions 
of Windows NT, and all architectures of Windows NT. However, the Windows NT version 4.0 
compact disc does not contain printer drivers for earlier versions of Windows NT or Windows 95. 
To use the Add Printer wizard to install earlier versions of Windows NT printer drivers, you must
have the installation media that contains the earlier version of the driver. The Add Printer wizard 
can install Windows 95 printer drivers from a share which contains decompressed Windows 95 
printer driver files and printer .INF files, The Add Printer wizard cannot install files directly from
a Windows 95 compact disc because the files are compressed on the compact disc. 

Windows 95 Printer Drivers on Windows NT 
Windows 95 printer drivers can be installed on computers running Windows NT. The printer 
drivers can be obtained from an existing Windows 95 installation or from a Windows 95 compact 
disc. Be aware that drivers on the Windows 95 compact disc must be decompressed before they 
can be installed on a Windows NT computer. Before you decompress the files, first create a 
directory for the decompressed files.
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To decompress files from the Windows 95 compact disc
1. At the command prompt of the computer running Windows NT, type md c:\win95. flat
   Flat indicates that the files in the directory are not compressed.
2. Insert the Windows 95 compact disc in the CD-ROM drive on the computer running Windows 
NT.
3.  From the command prompt, switch to the CD-ROM drive. 
4. Type cd \win95.
5. Type extract /a /e win95_02.cab /L c:\win95.flat.
6. Then type extract /a /e precopy1.cab /L c:\win95.flat

Upgrading Printer Drivers for Non-Native Processors
Non-native printer drivers (for example, x86-based printer drivers on a Digital Alpha computer) 
are not always upgraded during Setup. In some cases, new printer drivers must be installed using 
the Printers folder.

Non-native printer drivers are upgraded only if you upgrade a previous version of Windows NT 
from a compact disc, and you start Setup by booting your computer from a Windows NT 4.0 
installation floppy disk or the Windows NT compact disc. If you install Windows NT version 4.0 
using Winnt.exe or Winnt32.exe, the non-native printer drivers are not updated.

Remote Printer Administration
To provide quick access to the printer folder for several servers, drag and drop the remote printer 
folders to your local printer folder.

To add remote printer folders to the local printer folder
1. Click Start and then click Run.
2. Type the name of the print server preceded by two backslashes (\\).
3. Drag the printer folder to your local printer folder. If necessary, follow the on-screen 
instructions to install the printer driver.

PriorityClass Registry Entry No Longer Supported
Windows NT Workstation and Windows NT Server no longer support the \
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Print\PriorityClass registry 
entry. You do not need to remove it; it is simply ignored. 

You can now use SpoolerPriority instead of PriorityClass. SpoolerPriority can be set to 
IDLE_PRIORITY_CLASS, NORMAL_PRIORITY_CLASS, or HIGH_PRIORITY_CLASS. If it 
is set to anything else, Windows NT defaults to NORMAL_PRIORITY_CLASS. The registry 
value type for SpoolerPriority is REG_DWORD.

By default, there is no SpoolerPriority entry in the Registry and the process priority is 
NORMAL_PRIORITY_CLASS.

Long Printer Names
Several Windows version 3.x applications cannot print to a printer if the printer name contains 
more than a specified number of characters. Some applications will generate a General Protection 
Fault if this is attempted. Other applications may not print to any printer, even printers with short 
names, if the default printer has a "long" name. To resolve these problems, rename the printers 
used with the applications to shorter names and make one of those printers the default printer. See 
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"General Printing Issues" later in this document.

Configuring Your Printer's DIP Switch Settings
The following printer models require certain DIP switch settings in order to work properly in 
Windows NT. Make sure you configure your printer's DIP switch settings before you install the 
printer. 

Canon Bubble-Jet BJ-10e, BJ-10ex, and BJ-130e
All DIP switches should be set to the factory-default position. For the BJ-10e and BJ-130e models,
this is the OFF position.

Digital 9-Pin and 24-Pin Printers Supported by Windows NT
These printers should be set to Emulation (IBM ProPrinter) mode. See your printer manual for 
details on how to set the emulation.

Digital DECWriter 95

To use a Digital DECWriter 95 printer with Windows NT version 4.0
1. Upgrade your system with Windows NT version 4.0. 
2. Remove the printer model Digital DECWriter 95 from the Printers folder and reinstall the printer 

again by using the Add Printer wizard.
3. Set the DIP switches for ESCP2MS emulation mode.

Digital Laser Printers Supported by Windows NT
Printers listed that say (LJ) after the model name must have an HP LaserJet emulation cartridge 
installed. The printer must be set to LaserJet mode. See your printer manual for details on how to 
set the emulation.

Epson 9-Pin and 24-Pin Printers Supported by Windows NT
The following DIP switch settings are required for all Epson 9-pin and 24-pin printers: 
Auto LineFeed: OFF Skip Over Perf: OFF

Fujitsu 9-Pin and 24-Pin Printers Supported by Windows NT
The following DIP switch settings are required for all Fujitsu 9-pin and 24-pin printers: 
Color: AUTOSEL LF Code: LF Only CR Code: CR Only Emulate: DPL24/DPL24C

Mannesmann Tally 9-Pin and 24-Pin Printers Supported by Windows 
NT 
The emulation on the MT 130/9, MT 131/9, MT 230/9, MT 230/18, and MT 340 models should be
set to ANSI + IBM ProPrinter. See your printer manual for details on how to make this change. 

The emulation on the MT 130/24, MT 131/24, MT 230/24, and MT 330 models should be set to 
ANSI + Epson LQ2500 emulation. See your printer manual for details on how to make this 
change.

Olivetti 9-Pin and 24-Pin Printers Supported by Windows NT 
These printers should be set to Epson mode. See your printer manual for details on how to set the 
emulation.

Seikosha LT-20
The following DIP switch setting is required: 
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AGM mode: ON Code page: 850

Hewlett-Packard, Canon, and PCL Printers 
This section contains information specific to printing on Hewlett-Packard, Canon, and PCL 
printers.

PCL Printers: Setting Printer Memory
When you create a PCL printer, make sure that the memory specified in the printer’s Properties 
Device Settings tab matches the memory your printer contains. Specifying an incorrect amount of 
memory can cause the printer to print incorrectly. 

HP LaserJet IIIsi Language Switching
System language switching must be set to ON (SYS SWITCH=ON*) when printing to LaserJet 
IIIsi printers. If language switching is set to OFF, the printer may not print. 

HP LaserJet IIIsi in PostScript Mode
If you are using a LaserJet IIIsi printer in PostScript mode, unless you are writing PostScript 
programs and need error information for debugging, make sure the PRT PS ERRS option on your 
printer panel menu is turned off (the factory-default setting). If this option is on, your print jobs 
pause, and a message appears on your printer panel each time a PostScript error is encountered. In 
most cases, your documents still print, but the printing process is interrupted.

HP LaserJet Series III:  Upgrading Printer Drivers
The HP LaserJet III printer driver included with Windows NT is named HPPCL5MS.DRV. In 
earlier versions of Windows, this driver was named HPPCL5A.DRV. If you upgrade to Windows 
NT, the Setup program updates the printer driver for the HP LaserJet III printer. However, some 
applications store the information about the printer driver file with the document, and if you try to 
print a document that you created before you upgraded to Windows NT, you may receive a 
message notifying you that the printer driver cannot be found. If this problem occurs, choose the 
Printer Setup command in your application to update the driver information stored in the 
document. 

Hewlett-Packard 5L
When you print to your HP LaserJet 5L the following error message might appear:

Error writing to <port name> for <document name>. The system cannot find the file specified.

This error might indicate that your HP LaserJet 5L failed to power-on (or "wake up") after entering
Sleep Mode.

If your HP LaserJet 5L fails to power-on (or "wake up") after entering Sleep Mode, contact 
Hewlett-Packard at (208) 323-2551.

HP PaintJet XL Margins
You should set all margins to at least 0.5-inch for the PaintJet XL. If clipping occurs, increase the 
margin on the clipped side. 

Additional Printers and Font Packages
This section contains information specific to font packages and printing on miscellaneous printers.
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Digital PrintServer Printers
Digital Equipment Corporation PrintServer printers are smart devices that can be soft loaded from 
your Windows NT Workstation or Server by using bootp and tftp.

If your printer is configured but will not soft load, and if ?54 appears on the front panel of the 
PrintServer, try the following:

· Configure the proper hardware address for the PrintServer printer in Printers folder. Select the 
PrintServer printer in the Printers folder. Right-click the printer, and click Properties. Click the
Ports tab, and then click Configure Port.
If you are not sure of the hardware address, check the Print Servers front panel after starting. 
The panel will display the hardware Ethernet address.

· The PrintServer printer and the Windows NT system must be in the same TCP/IP subnet to soft 
load the printer. You may print to a PrintServer printer from anywhere on your network, 
regardless of subnet.

· Check your network hardware. Some types of hardware (bridges, for example) may be 
configured to filter bootp packets. To resolve this problem, soft load the PrintServer printer 
from a Windows NT system that is on the same side of the bridge as the printer, or have your 
network administrator disable bootp packet filtering on that bridge.

Printing from ThinkPad 7xx Computers
If printing from the ThinkPad 7xx results in illegible output, you may need to change, in the BIOS 
setup program, parallel port arbitration in the computer's system setup to Disabled. This will force 
the parallel port to no-DMA ISA computer-compatible mode and it will resolve the data handshake
error with some printers.

To change parallel port arbitration in the computer's system setup to disabled

1. Turn on the ThinkPad.
2. Press CTRL+ALT+INS after memory check. Enter a password if required. 

The IBM logo will appear.
3. Press ENTER.
4. Click Set Configuration, and then press ENTER.
5. Click Change Configuration, and then press ENTER.
6. Click Parallel Port Arbitration Level. Press F6 several times until Disabled appears.
7. Press F10 to save the current setting. Press ENTER.
8. Press F3 twice to exit the setup program, and then press ENTER to start the operating system.

If this procedure does not resolve the problem, contact Xircom for a driver update.

Printing Graphics on Canon Bubble-Jet BJ 10e or BJ 130e
If you are printing in 360x360 dpi graphics mode and parts of the graphics images in your 
documents are missing, make sure the DIP switch to control graphics image density is set to 
HIGH.

Fonts with Epson LQ 510, LQ 850, and LQ 1050 Printers
The Epson LQ 510, LQ 850, and LQ 1050 printer drivers support the full set of fonts provided 
with the latest versions of these printer models. Earlier versions of these printer models only 
support the Roman and Sans Serif fonts.

TrueType Fonts on Kyocera F-series Printers
To print TrueType fonts on Kyocera F-series printers, make sure that the Download TrueType 
Fonts check box is cleared in the Advanced Document Properties dialog box when configuring 
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your printer. Otherwise, TrueType fonts may not print correctly.

Soft Fonts on Mannesmann Tally MT 92C
Only HP LaserJet compatible fonts can be downloaded and only if the 256K memory card is fitted.
HP DeskJet compatible fonts will not work.

Cut-Sheet Feeder on NEC Pinwriter P7 Printer
The Paper Source option, Cut Sheet Feeder, does not work properly with the NEC Pinwriter P7 
printer. To use the cut-sheet feeder as the paper source, you must specify a left margin of about 
three inches for your document so that text prints correctly on the page.

Feeding Paper on Fujitsu 9-Pin Dot-matrix Printers
The manual-feed option is not supported on Fujitsu 9-pin dot-matrix printers. All paper is 
automatically fed to the printer from the roller.

Changing Printer Settings with Bitstream Facelift Version 1.0
With some applications, you can change the settings for your printer on a per-page basis. You 
cannot use this feature in Bitstream Facelift version 1.0 when printing multiple-page documents.

Setting Fonts for a Specific Printer using Crosstalk 2.2 for Windows
An error message appears when you attempt to set the fonts for the specific printer by using the 
Print Setup dialog box. To work around this problem, perform the following steps:

To set fonts within CrossTalk 2.2 for Windows
1. Click Start, point to Settings, and then click Printers.
2. Right-click the desired printer, and then click Set As Default.
3. Close the Printers window.
4. Open Crosstalk.
5. On the File menu, click Printer Setup.
6. Select Default Printer, and then set the font for the default printer.
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